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Mygtukai dokumentui tvarkyti (Standard) 
Sukuria 
tuščią lapą 

Išsaugo 
dokumentą 

Spausdina 
dokumentą 

Tikrina 
gramatines 
klaidas

Iškerpa 
fragmentą 

Panaikintiems 
veiksmams pakartoti 

Lentelių 
rėmeliams 
tvarkyti

Excel lentelei 
dokumente sukurti

Tekstui 
stulpeliais 
suskirstyti 

Vaizdo 
masteliui 
keisti 

Šalia dokumento 
parodo jo turinį 

Žinynas 

Dokumentui 
elektroniniu 
paštų siųsti 

Dokument
ui iškviesti 

Parodo, kaip 
atrodys dokumentas 
jį išspausdinus 

Įterpia 
fragmentą

Kopijuoja 
fragmentą 

Stiliui 
kopijuoti 

Paskutiniams 
veiksmams 
panaikinti

Hipernuorodai 
įterpti

Lentelei 
dokumente 
sukurti 

Įjungia 
mygtukų 
rinkinį 
piešimui 

Parodo paslėptus 
formavimo 
simbolius 

Mygtukų 
rinkiniui 
papildyti

 
 
 

 
Mygtukai dokumentui formuoti (Fomatting) 

 

 

Šrifto 
dydžiui 
keisti Tekstą pabraukia 

Pastraipą lygiuoja 
simetriškai dokumento 
centre 

Pastraipą lygiuoja 
abiejuose kraštuose 

Pažymi pastraipas pastraipas 
parinktais simboliais 

Atitraukia 
pastraipą nuo 
kairiojo 
krašto 

Rėmeliams 
parinkti 

Pastraipos 
teksto 
stiliui 
keisti 

Šriftui 
keisti 

Tekstą 
pastorina 

Tekstą paverčia 
kursyvu 

Pastraipą 
lygiuoja 
kairiajame krašte 

Numeruoja 
pastraipas

Pritraukia 
pastraipą prie 
kairiojo krašto 

Teksto 
spalvai 
keisti 

Pastraipą 
lygiuoja 
dešiniajame 
krašte 

Teksto fono 
spalvai 
keisti
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Mygtukai lentelėms tvarkyti (Tables and Borders) 
 

 

 
 
 

 
Dažniausiai naudojami valdymo klavišai ir komandų mygtukai 

 
Tarp klavišų, kuriuos reikia paspausti kartu, rašomas pliuso ženklas. Pavyzdžiui, užrašas 

Ctrl+V reiškia, kad, paspaudus klavišą Ctrl ir jo neatleidus, reikia paspausti klavišą V. 
Atmintinėje nurodyti komandų klavišai tinka amerikietiškai klaviatūrai, įjungus kitą klaviatūrą, kai 
kurie jų gali veikti kitaip. Komandoms valdyti reikia naudoti tik pagrindinėje klaviatūros dalyje 
esančius skaičių klavišus. 
 

Klavišai darbui su dokumentu 
Komanda Klavišu derinys ir 

mygtukas 
Komanda Klavišu derinys ir 

mygtukas 
Sukuria tuščią lapą 

Ctrl+N   
Dokumentui iškviesti 

Ctrl+0   
Uždaro dokumentą Ctrl+W Dokumento langui perskirti Alt+Ctrl+S  
Išsaugo dokumentą 

Ctrl + S   
Išjungia Word programą Alt+F4 

Teksto fragmentui ieškoti Ctrl+F Tęsia paiešką Alt+Ctrl+Y 
Teksto fragmentui ieškoti ir 
pakeisti Ctrl+H Žymekliui perkelti ties 

nurodytu požymiu Ctrl+G 

Grąžina žymeklį į ankstesnę 
vietą dokumente Alt+Ctrl+Z  Parodo lentelę žymeklio 

perkėlimo požymiui parinkti Alt+Ctrl+Home  

Nutraukia veiksmą Esc Panaikina paskutinį veiksmą 
Ctrl+Z  

Pakartoja paskutinį ar panaikintą 
veiksmą Ctrl+Y  

Įjungia spaudinio peržiūros 
(Print Loyout) darbo režimą Alt+Ctrl+P 

Įjungia dokumento sandaros 
(Outline) darbo režimą Alt+Ctrl+0 Įjungia paprastą (Normal) 

darbo režimą Alt+Ctrl+N 

Dokumentui spausdinti 
Ctrl+P  

Parodo, kaip atrodys 
dokumentas jį išspausdinus 
(Preview) 

Alt+Ctrl+l  

Lentelėms 
piešti 

Rėmelio 
stiliui 
parinkti 

Rėmelio 
spalvai keisti 

Laukelį 
fono 
spalvai 
keisti 

Sujungia 
pažymėtus 
laukelius

Teksto lygiavimui 
keisti 

Lentelių 
laukeliams 
trinti 

Rėmelio 
storiui 
keisti 

Rėmeliams 
parinkti 

Lentelei 
įterpti

Pažymėtiems 
laukeliams 
suskaidyti 

Suvienodina 
eilučių  aukštį

Suvienodina 
stulpelį plotį 

Pasuka 
tekstą 90° 
kom

Rikiuoja 
tekstą 
priešinga 
abėcėlei 

pu 

Sumuoja 
skaičius 
laukeliuose Rikiuoja 

tekstą 
abėcėlės 
tvarka 

Lentelės 
formai 
keisti
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Klavišų deriniai tekstui ir grafiniams objektams redaguoti 
Klavišų deriniai specialiesiems simboliams įterpti 

 
Komanda Klavišų derinys Komanda Klavišų derinys 

Eilutės pabaigos simbolis Shift+Enter Tritaškis (...) Alt+Ctrl+taškas 
Puslapio pabaigos simbolis Ctrl+Enter Prekės ženklo simbolis 

(™) 
Alt+Ctrl+T 

Stulpelio pabaigos simbolis Ctrl+Shift+Enter Registruoto prekės ženklo 
simbolis (®) 

Alt+Ctrl+R 

Žodžiams skiemenuoti Ctrl+- Autorystės simbolis (©) Alt+Ctrl+C 
Žodžiams brūkšneliu 
sujungti (-) 

Ctrl+Shrtt+- Tarpu atskirtiems 
žodžiams sujungti 

Ctrl+Shift+Tarpas 

 
Klavišu deriniai žymekliui tekste perkelti 

 
Komanda Klavišų derinys Komanda Klavišų derinys 

Per žodį į kairę Ctrl+⇐ Į vietą dokumente, kur 
prieš tai buvo dirbta Shift+F5 

Per žodį į dešinę Ctrl+⇒ Į dokumento pabaigą Ctrl+End 
Per pastraipą aukštyn Ctrl+⇑ Į dokumento pradžią Ctrl + Home 
Per pastraipą žemyn Ctrl+⇓ Žemyn PgDn 
Į eilutės pabaigą End Aukštyn PgUp 
Į eilutės pradžią Home Į lango apačią Alt+Ctrl+PgDn 
Į lango viršų Alt+Ctrl+PgUp   
 

Mygtukai piešimui (Drawing) 
 

 

Objektams 
pažymėti 

Figūrai 
pasukti 

Rodyklių, 
rėmelių ir 
kitokių 
figūrų 
rinkiniams Rodyklei 

piešti 

Elipsei 
piešti 

Stilizuotam 
tekstui 
rengti

Figūros 
fonui 
spalvinti

Raidėms 
spalvinti Linijų 

stiliui 
keisti 

Šešėliavimui 

Iškviečia komandas 
figūroms grupuoti, sekai 
nustatyti, tinklelio 
parametrams nurodyti, 
lygiuoti, asukti ir fermai 
keisti 

Tiesei  
piešti 

Stačiakampiui 
piešti 

Teksto 
laukeliui 
įterpti  

Objektui iš 
„ClipArt” 
rinkinio įterpti

Linijoms 
spalvinti

Linijų storiui 
keisti

Rodykės 
stiliui 
keisti 

Trimatei figūrai 
kurti 
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Paieškos dokumente mygtukai. Paieška... 
 
 

 
 
 

 
 
 
 

 

Pastabų
Išnašų 

Žymekliui 
perkelti 

Puslapių 

Skirsnių 

Paveiksliukų 

Antraščių 

Lentelių 

Informaciniu 
laukelių 

Pataisymų 

Teksto 

 
 
 
 
 
 
 
 

Mygtukai paveiksliukams tvarkyti (Picture) 
 
 
  
 
 
 
 

 

Paveiksliukui 
apkarpyti 

Didina 
kontrastą Paveiksliukui 

įterpti 

Pašviesina 
paveksliuką Paveiksliuko 

įterpimo būdui 
nurodyti  Nurodytą 

paveiksliuko spalvą 
nuskaidrina 

Mažina 
kontrastą 

Spalvų režimui 
parinkti 

Patamsina 
paveiksliuką

 
 
  
 
 
 

 

Grąžina pradinius 
paveiksliuko parametrus

Rėmelio ir 
linijų stiliui 
keisti

Poveiksliuko 
parametrams 
keisti

Mygtukai dokumentui redaguoti (Reviewing) 
 
 
 
 
 
 
 

 

Pastabai 
įrašyti 

Pastabai 
redaguoti 

Ištrina pastabą

Parodo 
ankstesnį 

Palieka 
pakeitimą

Teksto fono 
spalvai keisti Skirtingas dokumento 

versijas įrašo viename 

Dokumentui siusti 
elektroniniu paštu Ištrina 

pakeitimą

Pakeitimams 
žymėti

Parodo kitą 
pakeitimą 

Iškviečia 
„Outlook” 
užduočių langą 

Parodo ankstesnę 
pastabą 

Parodo kitą 
pastabą 
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Mygtukai tinklalapio kadrams formuoti (Frames) 
 
 

 
 
 

 
 
 

 

Įterpia kadrą kairiau Įterpia kadrą aukščiau Ištrina kadrą 

Kadro parametrams 
keisti 

Parodo kadro 
turinį Įterpia kadrą dešiniau 

 

 

Įterpia kodrą 
žemiau

 
 
 
 
 

Komandų mygtukų rinkinys darbui internete (Web) 
 
 
 
 
 
 

 

Vėliau žiūrėtam 
tinklalapiui 
atversti 

Tinklalapiui 
atnaujinti 

Paieškos 
svetainei 
iškviesti

Komandą kortelei darbui 
internete iškviesti 

Nurodyti 
tinklalapiui 
iškviesti 

Mėgstamiausių 
tinklalapių katalogui 
papildyti 

Palikti tik komandų mygtukų 
rinkinį darbui internete (Web) 

  
 
 
 
 
 
 
 

Anksčiau 
žiūrėtam 
tinklalopiui 
atversti 

Tinklalapio 
informacijos 
siuntimui 
sustabdyti 

 

Komandų mygtukų rinkinys tinklalapiui rengti (Web Tools) 
 
  
 
 
 
  
  
 
 

 
 
  
 
 
 
 
 
 

Slenkančia
m tekstui 
įterpti 

Garsui 
įterpti 

Slaptažodži
o laukeliui 
įterpti 

Paslėpto 
teksto 
laukeliui 
įterpti 

Į pradinę  
būseną 

Duomenims 
pateikti

Daugelio eilučių 
teksto laukeliui 
įterpti

Vienos eilutės 
teksto laukeliui 

Sąrašui 
įterpti 

Perjungikliui 
įterpti 

Jungikliui  
įterpti 

Piešimo 
režimui įjungti   

Parametrams 
keisti 

Microsoft 
scenorijų 

Išskleidžiama
jam sąrašui 
įterpti 

Paveikslėliui 
pateikti

Filmukui 
įterpti
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Komandų mygtukų rinkinys stilizuotam užrašui keisti (Word Art) 
 

 
 
 

 
 
 
 
 

 

Tarpams tarp 
simbolių 
keisti

Užrašui pasukti 
vertikaliai Simboliu dydžiui 

suvienodinti

Užrašui 
pasukti

Užrašo 
formai keisti 

Užrašui 
formuoti

Naujo užrašo 
stiliui parinkti 

Užrašui 
d ti

Užrašo stiliui 
keisti 

Stilizuoto užrašo 
įterpimo būdui parinkti 

Tekstui 
lygiuoti

 
 
 
 
 
 
 

 
Pastraipos paraščių formavimas liniuote 

 Dokumento lange virš dokumentui rengti skirto balto lauko yra horizontali liniuotė su 
šliaužikliais  ir tabuliavimo žymomis. Pele stumdami apatinius liniuotės šliaužiklius, nustatysite 
pastraipos kairįjį ir dešinįjį kraštus, o stumdami viršutinį -pastraipos pirmosios eilutės pradžią. 
Stumdami šliaužiklį , kartu stumsite pastraipos kairiojo krašto ir pirmosios eilutės šliaužiklius. 
 
 
 
 

 
 
 

Šliaužiklis pastraipos pirmosios eilutės pradžiai nurodyti 

Mygtukas tabuliavimo žymai Šliaužikliai pastraipos kraštams nurodyti 

Tabuliavimo žyma 

 
Liniuotes iš lango pašalinsite sužadinę komandą View ir išjungę komandos Ruler jungiklį. 

 

Puslapio antraštės ir paraštės (Headers, Footers) 

Puslapio antraštėse ir paraštėse rašomi puslapių numeriai, skyrių ir dokumento pavadinimai. 
Tekstas juose tvarkomas taip pat kaip puslapyje. 

Mygtukas duomenims iš 
išskleisto sąrašo 
automatiškai įterpti 

Puslapių 
skaičiui 
įterpti 

Grįžti į 
dokument
o rengimo 
režimą 

Puslapis 
į priekį 

Puslapis 
atgal 

Perkelti 
žymekliui 

Paslėpti tekstui 
puslapyje Laikui įterpti Datai įterpti 

Formuoti 
numeriui

Puslapio numeriui 
įterpti 

Formuoti 
puslapiui Poraščių vieta 
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Antraštės ar paraštės vietą pamatysite sužadinę komandas View, Header and Footer. Ji 
pažymėta punktyrine linija. Užpildžius viename puslapyje, Word programa užpildo jas ir kituose 
dokumento ar nurodytos jo dalies puslapiuose. Dialogo lange „Page Setup “galite nurodyti, antraštės ir 
paraštės aukštį. 

Dokumento redagavimo meniu (Edit) 
 

 
- Panaikino paskutinį veiksmą 
- Pakartoja paskutinį veiksmą 
- Perkelia dokumento fragmentą į kaupyklę 
- Kopijuoja dokumento fragmentą į kaupyklę 
- Įkelia objektą įš kaupyklės į dokumentą 
- Įkeliamo objekto formatui nurodyti 
- Nuorodai į dokumentą įterpti 
- Pažymėtam dokumento fragmentui ištrinti 
- Pažymi visą dokumentą 
- Teksto fragmentui ieškoti 
- Teksto fragmentams surasti ir pakeisti 
- Žymekliui perkelti į nurodytą vietą 
- Dokumentui su kitomis programomis susieti 

 
- Objektui redaguoti 

 
Dokumentų tvarkymo meniu (File) 

 
 
- Naujo dokumento tipui parinkti 
- Jau rengtam dokumentui iškviesti 
- Išjungia dokumentą 

- Išsaugo dokumentą 

- Dokumentui kitu failo vardu, adresu ar formatu išsaugoti 
- Dokumentui tinklalapio formatu išsaugoti 
- Įvairioms dokumento versijoms išsaugoti arba peržiūrėti 

- Parodo dokumentą tinklalapio formatu 

- Puslapio parametrams nurodyti 

- Parodo, kaip atrodys dokumentas jį išspausdinus 
- Spausdinimo parametrams nurodyti 
 
 
 
- Nurodyti, kur siųsti dokumentą 
- Iškviečia dokumento ir jo failo savybių dialogo langą 

- Paskutiniai rengti dokumentai 

- Išjungia Word programą 
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Dokumentų langu išdėstymo meniu (Window) 
 

- Atidaro langą naujai dokumento versijai 

- Surikiuoja atidarytu dokumentą langus 

 
- Dokumento langui perskirti 

 

Įrankiu meniu 
 

 
- Klaidoms ieškoti ir taisyti 
- Kalbai nurodyti 
- Puslapių, žodžių ir simbolių skaičiui parodyti 
- Teksto santraukai sudaryti 
- Rašant taisomoms klaidoms nurodyti 
- Dokumentams palyginti 
- Pakeitimams žymėti 
- Redaktorių padarytiems pakeitimams perkelti į vieną failą 
- Dokumento elementams apsaugoti 
- Tiesioginio bendravimo internete režimui parinkti 
- Duomenims iš duomenų bazių įterpti 
- Vokams ir etiketėms rengti 
- Iškviečia meistrą laiškams rengti 
- Makrokomandoms rengti ir tvarkyti 
- Dokumento šablonui nurodyti 
- Komandą klavišams ir mygtukams tvarkyti 

 
- Word programos parametrams keisti 

 
Vaizdo tvarkymo meniu (View) 

 
 
- Teksto režimas 
- Tinklalapio režimas 
- Spaudinio peržiūros režimas 
- Dokumento sandaros režimas 
- Komandą mygtukų rinkiniams iškviesti 
- Įjungia liniuotes 
- Šalia dokumento parodo jo turinį 
- Puslapinėms antraštėms ir poraštėms rengti 
- Parodo išnašą 
- Paaiškinimui redaguoti 
- Išskleidžia dokumentą per visą ekraną 

 
- Vaizdo masteliui keisti 
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Žinyno meniu (Help) 
 

 
- Atidaro pagalbos langą 
- Iškviečia biuro pagalbininką 
- Sukuria klaustuko žymę žinyno kortelei iškviesti 

- Pagalbai iš internete iškviesti 

- Pagalbai WordPerfect vartotojams iškviesti 

- Word programos klaidoms taisyti 

- Iškviečia informacinę kortelę 

 
 
 
 

Objektų įterpimo meniu (Insert) 
 

 
- Naujam puslapiui, stulpeliui arba skirsniui pradėti 
- Puslapiams numeruoti 
- Datai ir laikui įterpti 
- Fragmentų įterpimui automatizuoti 
- Informaciniams laukeliams įterpti 
- Simboliui įterpti 
- Pastabai įterpti 
- Išnašai įterpti 
- Paveiksliukams, lentelėms, formulėms numeruoti 
- Kryžminei nuorodai įterpti 
- Dalykų rodyklei, turiniui, paveiksliuku ir autorių sąrašams rengti 
- Paveiksliukui įterpti 

- Teksto laukeliui įterpti 

- Failui įterpti 
- Objekto tipui ir įterpimo sąlygai nurodyti 
- Žymai įterpti 

 
- Hipernuorodai įterpti 
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Formavimo meniu (Format) 
 

 
- Simbolių parametrams keisti 
- Pastraipos parametrams keisti 
- Pastraipų žymėjimo ir numeravimo stiliams keisti 
- Dokumento fragmento rėmeliui ir fonui keisti 

- Dokumentą suskirstyti stulpeliais 

- Tabuliavimo parametrams keisti 
- Pirmajai pastraipos raidei stilizuoti 
- Tekstui pasukti 
- Teksto tipui pakeisti 

- Ekrano fonui pakeisti 
- Tinklalapio apipavidalinimui keisti 
- Kadrams į tinklolapį įterpti 
- Dokumento automatinio formavimo režimui keisti 
- Dokumento šablono stiliams keisti 

 
- Įterpto objekto parametrams keisti 

 
Lentelių tvarkymo meniu (Table) 

 
 

 
- Lentelei piešti 
- Lentelei, eilutėms, stulpeliams bei laukeliams įterpti 
- Lentelei, eilutėms, stulpeliams bei laukeliams ištrinti 
- Lentelės laukeliams požymėti  
- Sujungia pažymėtus laukelius 
- Lentelės laukeliams skaidyti 
- Perskiria lentelę 
- Lentelės formai keisti 
- Lentelės eilučių aukščiui ir stulpelių pločiui automatiškai nustatyti 
- Naujome puslapyje kartoti pavadinimą eilutę 
- Pažymėtam tekstui paversti lentele ir atvirkščiai 
- Rikiuoti pagal pasirinktas taisykles 
- Formulei įvesti 
- Parodo mastelio tinklelį 

 
- Lentelės parametrams keisti 
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Naudingi kontekstiniai komandų meniu 
Kontekstinis komandų meniu, spragtelėjus klaidingai parašytą žodi 

 

- Žodžiai, kuriais siūloma pakeisti klaidingai parašytąjį 

- Nekreipti dėmesio 
- Papildo žodyną 
- Automatiškai taisomoms klaidoms nurodyti 
- Kalbai nurodyti 
- Ieškoti gramatiniu klaidų ir jas taisyti 

 
Kontekstinis komandų menių, spragtelėjus lentelės ženkliuką 

 
- Perkelio lentelės fragmentą į kaupyklę 
- Kopijuoja lentelės fragmentą į kaupyklę 
- Įkelta objetą iš kaupyklės į lentelę 
- Sujungia pažymėtus laukelius 
- Suvienodina eilučių aukščius 

- Suvienodina stulpelių pločius 

- Lentelei piešti 
- Dokumento fragmento rėmeliui ir fonui keisti 
- Lentelės formai keisti 
- Duomenims laukeliuose lygiuoti 
- Vienarūšiams dokumento objektams automatiškai  numeruoti 

 
- Lentelės elementu parametrams keisti 

 
Kontekstinis komandų meniu, spragtelėjus lentelės laukelį 

 
- Perkelia laukelio fragmentą į kaupyklę 

- Kopijuoja laukelio fragmentą į kaupyklę 
- Įkelia objetą iš kaupyklės į laukelį 
- Lentelei įterpti 
- Lentelės laukeliams ištrinti 
- Lentelės laukeliams suskaidyti 

- Dokumento fragmento rėmeliui ir fonui keisti 
- Tekstui pasukti 
- Laukeliams lygiuoti 
- Lentelės eilučių aukščiui ir stulpelių pločiui automatiškai nustatyti 

- Lentelės parametrams keisti 

- Pastraipoms parinktais simboliais pažymėti 

 
- Hipernuorodai įterpti 
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Kontekstinis komandų meniu, spragtelėjus pažymėtą teksto fragmentą 
 

- Perkelia dokumento fragmentą į kaupyklę 
- Kopijuoja dokumento fragmentą į kaupyklę 

- Įkelia objektą iš kaupyklės į dokumentą 

- Simbolių parametrams keisti 

- Pastraipų parametrams keisti 
- Pastraipų žymėjimo ir numeravimo stiliams keisti 

- Hipernuorodai įterpti 

 
- Sinonimams pasirinkti 

 
Klavišų deriniai dokumento fragmentams pažymėti 

 
Komanda Klavišų derinys Komanda Klavišų derinys 

Dešiniau žymeklio esančiam 
simboliui 

Shift+⇒ Išjungia klavišu F8 įjungtą 
žymėjimo režimą 

Esc 

Kairiau žymeklio esančiam simboliui Shift+⇐ Įjungia režimą stačiakampiui 
fragmentui krypties klavišais 
pažymėti 

Ctrl+Shift+F8 

Eilutės ilgio fragmentui dešiniau 
žymeklio 

Shift+⇓ Įjungia režimą žymėti fragmentui 
krypties klavišais per vieną 
simbolį arba per eilutės ilgį   

F8:⇐,⇒,⇑,⇓ 
 

Eilutės ilgio fragmentui kairiau 
žymeklio 

Shift+⇑ Paspaudus du kartus, pažymi 
vieną žodj, tris kartus - sakinį, 
keturi kartus - pastraipą 

F8 
 

Nuo žymeklio iki žodžio pabaigos Ctrl+Shift+⇒ Visam dokumentui Ctrl+A 
Nuo žymeklio iki žodžio pradžios Ctrl+Shift+⇐ Nuo žymeklio iki dokumento 

pradžios 
Ctrl + Shift+Home 

Nuo žymeklio iki eilutės pobaigos Shift+ End Nuo žymeklio iki dokumento 
pabaigos 

Grl+Shift+End 

Nuo žymeklio iki eilutės pradžios Shift+Home Nuo žymeklio iki pastraipos 
pradžios 

Ctrl +Shift+⇑ 

Nuo žymeklio iki pastraipos 
pabaigos 

Ctrl+Shift+⇓   

 
Klavišų deriniai dokumento fragmentams kopijuoti ir perkelti 

Komanda Klavišu derinys/mygtukas Komanda Klavišu 
derinys/mygtukas 

Perkelia dokumento fragmentą į 
kaupyklę Ctrl+X     

Kaupyklės turinį įterpia į 
žymekliu nurodytą vietą Ctrl + V   

Kopijuoja pažymėtą dokumento 
fragmentą į kaupyklę Ctrl+C      

  

 

Klavišai žymekliui lentelėje perkelti 
Komanda Klavišų derinys Komanda Klavišų derinys 

Per laukelį į dešinę Tab Į paskutinį stulpelio laukelį Alt + PgDn 
Per laukelį į kaire Shift+Tab Į pirmąjį stulpelio laukelį Alt+PgUp 
Į pirmąjį eilutės laukelį Alt+Home Į paskutinį eilutės laukelį Alt + End 
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Klavišų deriniai dokumento pažymėtiems fragmentams trinti 
 

Komanda Klavišų der inys Komanda Klavišų der inys
Kairiau žymeklio esančiam 
simboliui arba fragmentui trinti Backspace Dešiniau žymeklio esančiam žodžiui 

trinti Ctrl+Del 

Kairiau žymeklio esančiam žodžiui 
trinti Ctrl+Backspace Dešiniau žymeklio esančiam 

simboliui arba fragmentui trinti Del 

 
 

Klavišų deriniai lentelių elementams pažymėti 

Komanda Klavišų derinys Komanda Klavišų 
derinys 

Pažymėti tolimesniam laukeliui Tab Pažymėti ankstesniam laukeliui Shift+Tab 
Pažymėti gretimam simboliui ir 
laukeliui Shift+⇐,⇒,⇑,⇓ 

Pažymėti visai lentelei. Spauskite Alt ir 
mažosios klaviatūros klavišą 5, kai 
indikatorius „Num Lock” nešviečia. 

Alt+5 
 

 
 

Klavišų deriniai pažymėto žodžio arba teksto fragmento simboliams ir 
jų stiliui formuoti 

Komanda Klavišų derinys Komanda Klavišų derinys
Padidina šriftą vienu arba 
keliais punktais Ctrl+Shift+> Sumažina šriftą vienu arba 

keliais punktais Ctrl+Shift+< 

Padidina šriftą vienu punktu Ctrl+] Sumažina šriftą vienu punktu Ctrl+[ 
Pakeičia mažąsias raides 
didžiosiomis ir atvirkščiai 

Shift+F3; 
Ctrl+Shifl+A 

Pastorina tekstą ir atvirkščiai Ctrl+B 

Paverčia tekstą kursyvu ir 
atvirkščiai Ctrl+l Pabraukia tekstą ir atvirkščiai Ctrl+U 

Pabraukia žodžius ir atvirkščiai Ctrl+Shift+W Dvigubai pabraukia tekstą ir 
atvirkščia Ctrl+Shift+D 

Paslepia tekstą ir atvirkščiai 
(kai paspaustas mygtukas) Ctrl+Shift+H Pakeičia raides sumažintomis 

didžiosiomis ir atvirkščiai Ctrl+Shift+K 

Paverčia apatiniu indeksu ir 
atvirkščiai Ctrl+ = 

Paverčia viršutiniu indeksu ir 
atvirkščiai (+- mažosios 
klaviatūros klavišas) 

Ctrl+Shifl+ + 

Atkuria šablone nurodytą stilių 
Ctrl+Space 

Pakeičia tekstą atitinkamais 
šrifto „Symbol” simboliais 
(pvz., mn pakeičia į μυ) 

Ctrl+Shift+Q 

Rodo ekrane dokumento 
nespausdinamus simbolius Ctrl+Shift+* Kopijuoja nurodyto teksto 

stilių. Ctrl+Shift+C 

Formuoja tekstą atmintyje 
išsaugotu stiliumi Ctrl+Shift+V   
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Klavišų deriniai tekstui ir pastraipoms formuoti 
 

Klavišų deriniai pastraipos stiliui keisti 
Komanda Klavišų derinys Komanda Klavišų derinys

Įjungia automatinį formavimo režimą Alt+Ctrl+K Pastraipai suteikta stilių „Normai” Ctrl+Shift+N 
Pastraipai suteikia antraštės stilių 
„Heading 1” Alt+Ctrl+1 Pastraipai suteikia antraštės stilių 

„Heading 2” Alt+Ctrl+2 

Pastraipai suteikia antraštės stilių 
„Heading 3” Alt+Ctrl+3 Pastraipai suteikia sąrašo stilių „List” Ctrl+Shift+L 

Atkuria šablone nurodytą pastraipos 
stilių Ctrl+Q   

 
Klavišų deriniai pastraipoms lygiuoti 
Komanda Klavišų derinys Komanda Klavišų derinys

Lygiuoja pastraipą simetriškai lapo 
centre Ctrl + E  

Lygiuoja pastraipą abiejuose lapo 
kraštuose Ctrl+J   

Lygiuoja pastraipą kairiajame lapo 
krašte Ctrl+L    

Lygiuoja pastraipą dešiniajame 
lapo krašte Ctrl+R  

Atitraukia pastraipą nuo kairiojo 
krašto Ctrl+M  

Pritraukia pastraipą prie kairiojo 
krašto Ctrl+Shift+M

Atitraukia pastraipos eilutes, 
išskyrus pirmąją, nuo kairiojo 
dokumento krašto 

Ctrl+T 
Pritraukia pastraipos eilutes, 
išskyrus pirmąją, prie kairiojo 
dokumento krašto 

Ctrl+Shift+T 

 

Kiti klavišų deriniai 
Klavišų deriniai turiniui, kryžminėms nuorodoms (cross-references), 
dalykų rodyklei (index) ir išnašoms (footnotes, endnotes) rengti 

 
Komanda Klavišų derinys Komanda Klavišų derinys

Iškviečia kortelę turinio elementui 
nurodyti 

Alt+Shift+0 Iškviečia kortelę citatų sąrašo 
elementui nurodyti 

Alt+Shift+I 

Iškviečia kortelę daiykų rodyklės 
elementui nurodyti 

Alt+Shift+X Įterpia išnašą puslapio apačioje Alt+Ctrl+F 

Įterpia išnašą dokumento pabaigoje Alt+Ctrl+E Pastabai įrašyti Alt+Ctrl+M 
 

Klavišų deriniai pažymėto fragmento eilučių tarpams keisti 
 

Komanda Klavišų derinys Komanda Klavišų derinys
Normalus tarpas Ctrl+ 1 Dvigubas tarpas CtrI+2 
Pusantro tarpo Ctrl +5 Padidina arba sumažina tarpą prieš 

pastraipą 
Ctrl+0 

 
Klavišų deriniai darbui su tinklalapiu 

Komanda Klavišų derinys Komanda Klavišų derinys
Hipernuorodai įterpti Ctrl + K Perkelia žymeklį į ankstesnį tinklalapį Alt+⇐ 
Perkelia žymeklį į paskesnį tinklalapį Alt+⇒ Tinklalapio informacijai atnaujinti F9 
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Klavišų deriniai darbui su informaciniais laukeliais (fields) 
 

Komanda Klavišų derinys Komanda Klavišų derinys
Įterpia datos (Date) laukelį (2000 
02 14) Alt+Shift+D Įterpia sąrašo punkto numerio 

(Listnum) laukelį (i) Alt+Ctrl+L 

Įterpia puslapio numerio (Page) 
laukelį (5) Alt+Shift+P Įterpia laiko (Time) laukelį (10:07) Alt+Shift+T 

Įterpia tuščią informacinį laukelį ( ) Ctrl+F9 Parado nurodyto laukelio turinį 
arba įo kodą Shift+F9 

Parodo visų laukelių turinius arba 
kodus Alt+F9 Perkelia žymeklį į tolimesni 

laukelį F11 

Perkelia žymeklį į ankstesnį laukelį Shift+F11 Uždraudžia keisti informaciją 
laukelyje Ctrl+F11 

Leidžia keisti informaciją laukelyje Cfri+Shift+F11   
 

PATARIMAI 
 

Kaip sudaryti skaičiavimo lentelę? 
Word programos lentelėje galima apskaičiuoti nesudėtingus matematinius reiškinius, 

atlikti logines operacijas, nurodyti jų atlikimo sąlygas. Tam skirtas lentelių tvarkymo (Tables and 
Borders) mygtukas  (AutoSum) ir komandomis Table, Formula... iškviečiamas dialogo kortelė 
„Formula”. Jeigu norite į laukelį įrašyti formulę, įkelkite į jį žymeklį, iškvieskite dialogo kortelę 
„Formula “Jos laukelyje „Formula:” įrašykite formulę ir paspauskite OK. 
 
 
Formulės laukelis  

Skaičių formatų išskleidžiamasis 
sąrašas 

Įrašyta formulė apskaičiuos 
laukeliuose c1l,c2,c3,c4, d1, 
d2,d3,d4 skaičių vidurki. 

Funkcijų išskleidžiamasis sąrašas Dvitaškis (:) torp laukelių kodų 
nurodo, kad reikia atlikti veiksmą 
su laukelių, esančiu 
stačiakampyje nuo c1 iki d4, 
turiniais. 

Formulė pradedama lygybės 
operatoriumi, paskui iš sąrašo 
įkeliama funkcija. Jeigu reikia, 
rašomas kitas operatorius, vėl 
įkeliama funkcija ir t.t  

Jeigu laukelių kodai atskirti 
kableliais, veiksmai atliekami tik 
su skliausteliuose išvardytų 
laukelių turiniais 
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Kaip suskaidyti dokumentą skirsniais (Sections)? 

 
 
 

 
Naujos dokumento dalies pradžią reikia nurodyti žymekliu, pavyzdžiui, naujoje eilutėje. Paskui 

reikią sužadinti komandas Insert, Break.., dialogo kortelėje „Break” nurodyti dokumento skaidymo 
būdą, pavyzdžiui, „Continuous”, ir paspausti OK. Dabar, sužadinus komandą Format, reikia nurodyti 
naujos dalies formatą. Jeigu nurodysite Columns... ir dialogo lango „Columns “ laukelyje „Number of 
columns” įrašysite 2, tekstas bus rašomas dviejuose stulpeliuose. 
 

 

Teksto skaidymas: 
pradėti naują puslapį; 

pradėti naują stulpelį; 

tęsti tekstą kitoje tuščioje eilutėje. 

Dokumento skaidymas dalimis: 

pradėti naują dokumento dalį kitame puslapyje; 

pradėti naują dokumento dalį tame pačiame puslapyje; 

pradėti naują dokumento dalį lyginiame puslapyje; 

 
pradėti naują dokumento dalį nelyginiame puslapyje. 

 
 

Kaip rikiuoti duomenis lentelėje? 
 

Paspausdami mygtuką  ar  arba sužadinę komandas Table, Sort... ir dialogo kortelėje 
„Sort” nurodę reikiamus parametrus, galėsite nurodytame stulpelyje surikiuoti duomenis pagal abėcėlę 
didėjimo arba mažėjimo tvarka. Dialogo lange „Sort” dar galite liepti rikiuoti pagal skaičiaus reikšmę 
arba datą net trijuose susijusiuose stulpeliuose iš karto. 
 
 Laukeliai rikiuojamą duomenų tipui: tekstui, skaičiui arba datai 

nurodyti 
 

Laukeliai stulpeliams 
nurodyti 

Perjungikliai rikiavimo 
krypčiai nurodyti

Įjunkite,  kai viršutinėje 
eilutėje yra stulpelių 
antraštės, o ne duomenys 

 

Įjunkite, kai ir viršutinėje 
eilutėje yra duomenys 
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Kaip nurodyti paveikslėlio ar grafinio objekto įterpimo į tekstą būdą? 
 

Paveikslėlis ar grafinis objektas į tekstą gali būti įterptas kelias būdais. 
Jeigu norite pakeisti paveikslėlio ar grafinio objekto įterpimo būdą, spragtelėkite jį pele, 

nuspausdamijos dešinįjį klavišą kontekstiniame meniu sužadinkite komandą Format Picture ir dialogo 
kortelėje „ Format Picture\Layout” spragtelėkite pele paveikslėlį su pasirinktu įterpimo būdu. Didesnį 
pasirinkimą turėsite, paspaudę dialogo kortelės mygtuką Advanced. Paveikslėlio arba grafinio objekto 
vietą dokumente patogiausia pakeisti perkeliant jį pele. 
 

stačiakampyje 
prišliejant 
po tekstu 

virš teksto 
kaip pastraipa 
kaip simbolis 

tekste  
 

Kaip sukurti naują stilių arba pakeisti stiliaus parametrus? 
 
Jeigu norite sukurti naują stilių sužadinkite komandas Format ir Style... ir, paspauskite 

mygtuką New..., kortelės „New Style” laukelyje „Name:” įrašykite stiliaus pavadinimą, o laukelyje 
„Style type:” nurodykite, kam jis skirtas - visai pastraipai (Paragraph) ar tik pažymėtam teksto 
fragmentui (Character). Laukelyje „Based on:” nurodykite stilių, iš kurio bus kuriamas naujas stilius, o 
laukelyje „Style for following paragraph:” - tolimesnės pastraipos stilių. Paspaudę mygtuką Shortcut 
Key..., galėsite nurodyti klavišų derinį stiliui suteikti, o pažymėję jungiklį „Add to template “, - liepti 
sukurtąjį stilių priskirti dokumento šablonui. 
Pakeisti stiliaus parametrus galėsite, spragtelėję pele keičiamo stiliaus tekstą, sužadinę komandas 
Format, Style... ir paspaudę dialogo kortelės „Style “ mygtuką Modify... 
 
 
Stilių sąrašas Pastraipos 

pavyzdys 

Išskleidžiamasis sąrašas 
stiliams rūšiuoti 

Šrifto 
pavadinimas 

 

 

Stiliaus 
aprašymas 

Naujo stiliaus bendriesiems parametrams nurodyti Stiliui pakeisti Stiliui panaikinti 
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Vokų spausdinimas 
 

Norėdami išspausdinti vokus laiškams, sužadinkite komandas Tools ir Envelopes and Labels... Jeigu dialogo 
kortelės „Envelopes and Labels “ adresų laukeliai „Delivery address:” 

ir „ Return address:” tušti, juos užpildykite ranka arba iš adresų knygelių . Kai nenorite spausdinti siuntėjo adreso, 
įjunkite jungiklį „ Omit”. 

Jeigu norite nurodyti voko parametrus, paspauskite mygtuką Options..., dialogo kortelės „Envelope 
Options\Envelope Options” išskleidžiamajame sąraše „Evelope size:” nurodykite voko formatą, paspaudę laukelių 
„Delivery address:” ir „Return address: “mygtukus Font.., nurodykite adresų šriftus, išskleidžiamuosiuose sąrašuose „From 
left:” ir „From top” nurodykite, kuriose voko vietose spausdinti adresus. Jeigu paspausite mygtuką Printing Options, 
laukelyje „Feed methods” galėsite nurodyti, kuriuo būdu vokai bus dedami į spausdintuvą, o išskleidžiamajame sąraše 
„Feed from:” - kaip spausdintuvas paims vokus. 
 

Adresų knygelei atversti  Gavėjo adreso 
laukelis.  
Jeigu adresas yra 
laiške, laukelį 
užpildo Word 
programa 

Spausdinti 

Spausdinti vokui 
kartu su laišku 

Siuntėjo adreso 
laukelis. Jeigu 
adresas yra 
kortelėje 
„Options\User 
Information”, 
laukelį užpildo 
Word programa 

 

Voko formatui ir 
apipavidalinimui 
nurodyti 

 
 
 

  
Šrifto ir jo dydžio keitimas 
 
Paspaudę dokumento formavimo mygtukų juostoje (Formatting) mygtuką  esantį šalia šrifto 

pavadinimo laukelio, išskleisite sąrašą kuriame pamatysite visus įdiegtus šriftus ir galėsite nurodyti 
kitą šriftą, o paspaudę mygtuką šalia laukelio su šrifto dydžiu, išskleisite sąrašą, kuriame galėsite 
nurodyti šrifto dydį. Šriftą ir jo dydį taip pat galima įrašyti į jiems skirtus laukelius. 
 
Dokumento formavimo mygtuku juostos (Formatting) 
fragmentas 

 

 
Požymėtasis šriftas 

Rengiant dokumentą naudotu šrifty sąrašas 

Visų įdiegtų šriftų išskleidžiamasis sąrašas, kuriame yra ne 
tik šriftų pavadinimai, bet ir stiliai 
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Kaip nurodyti stilių? 
 

Pažymėto teksto fragmento arba žymekliu nurodyto baigtinio teksto elemento (pvz., pastraipos, 
pavadinimo) stilių nurodysite, išskleidę dokumento formavimo (Formatting) mygtukų sąrašą (Style) ir 
pele spragtelėję pasirinktą stilių. 
 

Dokumento formavimo mygtuką juostos 
(Formatting) fragmentas 

Skyriaus stiliaus pavadinimas ir šriftas 

Stiliai „Heading” yra skirti 
skyrių ir skyrelių 
pavadinimams, „BodyTetf”-
pagrindiniam tekstui, „List...” - 
sąrašams, „Caption” - užrašams 
po paveikslėliais, lentelėmis, 
„lndex” - dalykįi rodyklei, 
„TOC”-turiniui ir t.t. 

 

Skyrelio stiliaus pavadinimas ir šriftas 

 
 
 

 
Formulių rašymas 
 
Paprastas formules, pavyzdžiui, y = bx2 galima rašyti Word programoje esančiomis 

priemonėmis. Sudėtingoms formulėms rašyti yra skirta su Word komplektuojama Microsoft Equation 
programa. 
 

Kaip automatiškai taisyti klaidas? 
 

Jeigu norite nurodyti, kokias klaidas taisyti ir ką kuo pakeisti, sužadinkite komandas Tools ir 
AutoCorrect.. Dialogo kortelės „AutoCorrect” laukelyje „Replace:” įrašykite kodinę simbolių seką 
(Entry). Sekoje neturi būti tarpelių, ir ji neturi būti ilgesnė kaip 31 simbolis. Laukelyje,, With:” 
įrašykite simbolių seką, kuri automatiškai pakeistų dokumente išspausdintą kodinę seką. Norėdami 
įterpti sudėtingesnį dokumento elementą, pavyzdžiui, paveikslėlį, jį pažymėkite, paskui iškvieskite 
dialogo langą „AutoCorrect” ir užpildykite laukelį „Replace:”. Paspauskite mygtukus Add ir OK. 
 
Jungikliai pataisymų sąlygoms nurodyti: 

sekos antrąją didžiąją raidę pakeisti mažąja raide; 

sakinį pradėti didžiąja raide; 

dienu pavadinimus pradėti didžiąja raide; 

taisyti klaidas, kurios atsiranda atsitiktinai paspaudus 
klavišą Caps Lock; 

klaidas taisyti rašant 

Keistinų sekų stulpelis 

Pageidaujamų sekų stulpelis 

Mygtukas naujoms sekoms įvesti 

Mygtukas pažymėtoms sekoms ištrinti 
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Kaip numeruoti puslapius? 
 

Word programa puslapio numerius rašo papildomoje eilutėje. Kur ir kaip rašyti puslapių 
numerius, galite nurodyti komandomis Insert, Page Numbers... iškvietę dialogo kortelę „Page 
Numbers”. 
 
 

 
 
 

 

Nurodykite, ar numerius rašyti 
puslapio centre (Center), kairėje 
(Left) ar dešinėje (Rignt) pusėje 

Nurodykite, ar numerius rašyti 
puslapio apačioje (Bottom) ar viršuje 
(Top)

Įjungę jungiklį, liepsite rašyti 
numerį ir pirmajame puslapyje 

Nurodę, kur rašyti puslapių numerius, paspauskite dialogo kortelės „Page Numbers” mygtuką 
Formai... ir dialogo kortelėje „Page Number Format”parinkite numerių formatą. 
 
 

Jeigu norite nurodyti pirmojo puslapio numerį, įjunkite 
perjungiklį „Start ai:” ir laukelyje įrašykite pirmojo 
puslapio numerį

Numeruoti nuo buvusio skyriaus 

Nurodykite skirtuką tarp puslapio ir skyriaus 

Nurodykite skyriaus stilių 

Jeigu norite matyti ir dokumento skyriaus numerį, 
įjunkite jungiklį 

Pasirinkite numerių formatą 
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Naudingi žinoti Word 2000 programos apribojimai 
 

Ribinis parametras Reikšmė 
Failo dydis 32 megabaitai 

Stulpelį skaičius lentelėje 63 
Vartotojo (Custom) žodyno talpa 1 0000 žodžių arba 366590 baitų 

Automatiškai įvedamo teksto fragmento 
pavadinimo (AutoText) ilgis 32 simboliai 

Žymos vardo ilgis 40 simbolių 
Sudėtinio dokumento (Master Document) 

dalių skaičius 255 

Simbolių skaičius eilutėje 768 
Puslapio ilgis ir plotis 55,9 cm 

 
Pakeistos Word 95 programos komandos redaktoriuje Word 2000 

 
Word 95 komandos Atitinkamos Word 2000 komandos 

File meniu komandos 
Templates Tempiate and Add-lns (komandos Tools meniu) 
Send Mail Recipient (komandos Send To meniu) 
Add Routing Slip Routing Recipient (komandos Send To  meniu) 

Edit meniu komandos 
AutoText Insert meniu komandos 
Bookmark  Insert meniu komandos  

View meniu komandos 
Page Layout Print Layout meniu komandos  
Master Document Sujungta su Outline 
Annototions Comments 

Insert meniu komandos 
Annotation Comment 
Frame Nėra (naudoti komandas Text Box ir Picture) 
Form Field Nėra (naudoti Forms komandų mygtukus) 
DataBase Nėra (naudoti Database komandų mygtukus) 

Format meniu komandos 

Heading Numbering Bullets and Numbeering\ Outline Numbered 
Style Gallery Theme 
Picture Picture (veikli tik pažymėjus paveikslėlį) 

Tools meniu komandos 
Spelling ir Grammar Sujungtos komandoje Spelling and Grammar 
Thesaurus ir Hyphenation Perkeltos į Language meniu 
Revisions  Highlight Changes (komandos Track Changes meniu) 

Table meniu komandos 
Insert Table Table (komandos Inisert meniu) 
Delete Cells Cells (komandos Delete meniu) 
Select Row, Select Column, Select Table Column, Row, Table (komandos Selert meniu) 
Convert Text to Table Komandos Convert meniu 
Convert Table to Text Komandos Convert meniu 
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Pakeistos Word 97 komandos redaktoriuje Word 2000 
 

Word 97 komandos Atitinkamos Word 2000 komandos 

View meniu komandis 
Online Layout Nėra 
Page Layout Print Layout 
Master Document Sujungta su Outline 

Format meniu komandis 
Style Gallery Theme 

Table meniu komandis 

Insert Table Table (komandos Insert meniu) 
Insert Columns Columns to the Left, Columns to the Right (komandos 

Insert meniu) 
Insert Rows Rows Above, Rows Below (komandos Insert meniu) 
Insert Cells Cells (komandos Insert meniu) 
Delete Cells (Rows, Columns) Cells, Rows, Columns, Table (komandos Delete meniu) 
Select Row, Select Column, Select Table Row, Column, Table, Cell (komandos Select meniu) 
Distribute Rows Evenly Komandos AutoFit meniu 
Distribute Columns Evenly Komandos AutoFit meniu 
Convert Text to Table Komandos Convert meniu 
Convert Table to Text Komandos Convert meniu 
 

Dažniausiai kylantys klausimai 

? Kaip rasti ir pašalinti nereikalingus 
failus, kurie kaupiasi, netaisyklingai 
išjungus kompiuterį? 

ymėkite 
tm

? Kaip sparčiau rašyti pasikartojančias 
f

eturis pirmuosius įterpiamos 
ės

pats p

? K

failų tipų sąraše “Files from 
type:” nurodykite “Recover Text from Any File” 
ir paspauskite mygtuką Open. Word turėtų įkrauti 

te vieną dokumentą, pasirinkite 

Compa  Documents..., dialogo kortelėje “Select 
File to  

ė “Drop Cap” “Position”

atžvilgiu, išskleidžiamajame šriftų sąraše “Font:” 
nurodykite šriftą laukelyje “Lines to drop:” - 
raidės a

stačiak i iš eilės, jeigu pele 
ukart spragtelsite atitinkamą komandų mygtuką 

figūrai 

 
Nesužadinkite jokios programos, 

atidarykite katalogą ...Windows\Temp, paž
„ *. p” failus ir paspauskite klavišą Del. 

razes? 
 
Pažymėkite frazę, pasirinkite meniu punktą 

Insert ⇒ AutoText ⇒ New... ir paspauskite 
dialogo kortelės “Create AutoText” mygtuką OK. 
Dabar, parašius k
fraz  simbolius ir paspaudus klavišą Enter, Word 

abaigs frazę. 

aip gelbėti pažeistame Word 
dokumento faile esantį tekstą? 

 
Dialogo korteles “Open” 

išskleidžiamajame 

dokumento tekstą. 
 
 

? Kaip palyginti du dokumentus? 
 
Iškvieski

meniu punktą Tools ⇒ Track Chages ⇒ 
re
 Compare With Current Document” 

pažymėkite antrą dokumentą ir paspauskite 
mygtuką Open. 

? Kaip išskirti pastraipos pirmąją raidę? 
 
Įkelkite žymeklį įpastraipą, pasirinkite 

meniu komandą Format ⇒ Drop Cap..., dialogo 
kortel s  lauke  nurodykite 
pastraipos pirmosios raidės padėtį pastraipos 

ukštį eilutėmis, o laukelyje “Distance from 
text:” - atstumą iki teksto ir paspauskite mygtuką 
OK. 

? Kaip sparčiau piešti kelias vieno tipo 
figūras? 

 
Kelias vieno tipo figūras (pvz., 

ampius) galėsite nupiešt
d

piešti. Piešimo režimą išjungti patogiausia 
pele dar kartą spragtelėjus komandų mygtuką arba 
paspaudus klavišą Esc. 
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dos pavadinimą, paspauskite 

 ir atlikit

arba p s ⇒ Macro ⇒ 
top R

 

traipą pažymėsite pele dukart 

dokum
 pažymėsite paspaudę klavišą Ctrl ir 

ele spragtelėję bet kurioje sakinio vietoje (taip pat 
ir lentel

tą dokumento vietą, prieš tai 
s 
ym

į išk ragtelėkite dešiniuoju pelės 
lavišu virš darbo lauko ir kontekstiniame meniu 

pasirink as e

andų mygtuku rinkinį 
papildyti nauju mygtuku? 

 meniu punktą Vew ⇒ Toolbars 
 Customize..., dialogo lango 

„Custom

inkinį ir atleiskite pelės 
lavišą. Dabar indeksui parašyti arba pažymėtam 

m
koman

ų rinkinio į dialogo lango 
Customize\Toolbars“ sąrašą „Categories:” ir 

 

 K

hat:” 
kite ieškomą seką. 

 Kaip atrodys dokumentas tinklalapio 

? Kaip paspartinti sudėtingų 
pasikartojančių dokumento rengimo 
operacijų vykdymą? 

 
Sukurkite makrokomandą 

pasikartojančioms, operacijoms vykdyti. Tam 
pasirinkite menu punktą Tools ⇒ Macro ⇒ 
Record ⇒ New Macro..., dialogo kortelės 
“Record Macro” laukelyje “Macro name:” 
įrašykite makrokoman
OK e makrokomandai skirtas operacijas. 
Jas atlikę, paspauskite mygtuką “Stop Recording” 

asirinkite meniu punktą Tool
S ecording. Jeigu prieš paspausdami OK, 
paspausite mygtuką Toolbars, programa sukurs 
mygtuką makrokomandai paleisti ir priskirs jį 
kortelės “Customize\Toolbars” mygtukų 
kategorijai “Macro”. 

? Kaip pele sparčiai pažymėti 
dokumento fragmentus? 

 
Žodį pažymėsite jį dukart spragtelėję pele 

(taip pat ir lentelėje). 
Eilutę pažymėsite pele spragtelėję 

kairiajame dokumento laukelyje ties eilutės pradžia.  
Lentelės eilutę pažymėsite pele spragtelėję 

lentelės eilutės kairėje, stulpelį - pele spragtelėję 
virš stulpelio.  

Pas
spragtelėję kairiajame dokumento laukelyje ties 
pastraipa. Triskart spragtelėję pažymėsite visą 

entą. 
Sakinį

p
ėje).  
Bet kurį fragmentą pažymėsite braukdami 

perjįpele, nuspaudę jos kairįjį klavišą (taip pat ir 
lentelėje). 
 

? Kaip tam tikra tvarka kelis dokumento 
fragmentus perkelti į kitą dokumento 
vietą? 

 
Pažymėkite pirmąjį fragmentą ir 

paspauskite klavišus Ctrl+F3. Tą patį padarykite ir 
su kitais perkeliamais fragmentais. Paskui 
perkelkite žymeklį į įsimintų fragmentų įterpimo 
vietą ir paspauskite klavišus Ctrl+Shift+F3. 

Kelis dokumento fragmentus taip pat galite 
lengvai perkelti į ki
juo laikinai perkėlę ant darbo lauko. Tam 
paž ėkite fragmentą, paspaudę klavišus Ctrl+X, 

irpkite, tada spj
k

ite komandą Paste. Pulte atsir  fragm nto 
ženklas „Document Scrap... “. Tą patį padarykite ir 
su kitais perkeliamais fragmentais. Paskui 
perkelkite žymeklį į fragmentų įterpimo vietą 
dokumente ir reikiama seka pele perkelkite 
fragmentus iš pulto. 
 

? Kaip greitai iškviesti neseniai rengtą 
dokumentą? 

 
Pasirinkite meniu punktą Tools ⇒ 

Options.., dialogo kortelėje „Options\General” ties 
įjungtu jungikliu „Recently used files list:” 
esančiame laukelyje skaičių 4 pakeiskite didesniu 
(pvz., 9) ir paspauskite OK. Tada, sužadinę 
komandą File, galėsite iškviesti bet kuriuos iš 
devynių paskutinių išsaugotų dokumentų. 

 

? Kaip kom

 
Pasirinkite

⇒
ize\Toolbars” sąraše „Categories:” 

nurodykite mygtuko kategoriją (pvz., Format), 
sąraše „Commands:” raskite reikiamą mygtuką 
(pvz., Subscript), nuspaudę pelės kairįjį klavišą 
perkelkite į mygtukų r
k
frag entui paversti indeksu užteks paspausti 

dų mygtuką. 
 

? Kaip pasalinti mygtuką iš komandų 
rinkinio? 

 
Pasirinkite meniu punktą Vew ⇒ Toolbars  

⇒ Customize.., ir, nuspaudę pelės kairįjį klavišą 
perkelkite jį iš mygtuk
„
atleiskite pelės klavišą.  

? aip naudoti specialius simbolius 
paieškai palengvinti? 

 
Wordprograma dokumentųteksto fragmentų paieška 
bus universalesnė, jei naudosite specialius 
simbolius. Tam pasirinkite meniu punktą Edit ⇒ 
Find..., dialogo kortelėje „Find and Replace” 
paspauskite mygtuką More, tada kortelėje įjunkite 
jungiklį „Use wildcards“ ir laukelyje „Find w
įrašy
 

?
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ngiamas dokumentas atrodys 
terneto naršyklės lange, pasirinkite meniu punktą 

 ⇒
išsaugosite tinklalapio formatu pasirinkę meniu 

unktą File ⇒ Save as Web Page, užpildę dialogo 
kortelę  S

pradžios eilutę ir teksto lygiavimą? 
 
Pele dukart 

 

pragtelėsite centre - lapo viduryje, o 
 

dokumento 

⇒ 
oolbar ⇒

daryti, kad spausdinamame 
dokumente būtų vandens ženklas? 

 
 

eader
 paspauskite mygtuką 

Show/H mentą 
rafinį 

mygtuk

Simbolis boliai pabraukti)

formate? 
 

Jeigu norite pamatyti, kaip rengiamas 
dokumentas atrodys tinklalapio formate, pasirinkite 
meniu punktą View ⇒ Web Layout. Jeigu norite 
pažiūrėti, kaip re
in
File  Web Page Preview. Rengiamą dokumentą 

p
„Save As” ir paspaudę mygtuką ave. 

 

? Kaip pele nurodyti naujos pastraipos 

? Kaip nukopijuoti kelis 

spragtelėkite eilutę, kurioje ketinate 
pradėti pastraipą. Jeigu spragtelėsite kairiajame
lapo krašte, tekstas bus lygiuojamas kairiajame lapo 
krašte, jeigu s
jeigu dešiniajame krašte, tekstas bus lygiuojamas
dešiniajame krašte. 
 
 

fragmentus? 
 

Pasirinkite meniu punktą View 
T s  Clipboard. Atsiras „Clipboard (1 of 
12)” juosta, į kurią galima nukopijuoti net dvylika 
dokumento fragmentų. Spragtelėję pele juostoje 
nukopijuoto fragmento ženklą įterpsite fragmentą į 
žymekliu nurodytą dokumento vietą. 
 

? Kaip pa

Jeigu norite dokumente išspausdinti
vandens ženkl
H

ą sužadinkite komandas View ir 
 and Footer. Paskui mygtukų juostoje 

Header and Footer
ide Document Text, įkeliate į doku

g objektą ar paveikslėlį ir paspauskite 
ą Close. 

Nurodo, ką simbolis pakeičia arba suranda Pavyzdys (Pakeisti sim
Atras visus žodžius arba skaičius, kuriuose

ys 

? ?ėdė ⇒ kėdė, dėdė; ??dė ⇒ kėdė, dėdė, 

1?34  ⇒1234,1334, 1434, ...,1034 
klaustuko vietoje yra skirtingos raidės arba 
skaitmen

 pūdė, sūdė  

Atras visas simbolių sekas, prasidedančias
prieš * parašytais simboliais ir pasibaigiančias

e 
„Aš noriu namo” pirmą kartq pažymės 

mo” 
už * parašytais simboliais 

* Jeigu jrašysite „n* m”, paieška sakinyj

„Aš noriu namo”, o antrą kartą „Aš 
noriu na

Suras vieną iš skliausteliuose nurodytu 
simboliu 

[ ] d[au]žo  ⇒dažo, dužo 

Suras vieną skliausteliuose nurodytos sekos [-] a, lipo, lips (neras „lipu”) 
simbolį 

lip[a-s] ⇒ lip

Suras vieną simbolį, išskyrus tuos, kurie [!] , lips, lipu (neras „lipo”) 
nurodyti skliaustuose 

lip[!o] ⇒ lipa

Suras simbolį, išskyrus skliaustuose 
lius 

[!x-z] lip[!a-o] ⇒ lips, lipu (neras „lipa” ir 
nurodytos sekos simbo „lipo”) 
Suras n posikartojančių simbolių ar išraiškų {n} 1{2}00 ⇒ 1100, 11100 (neras 1000) 
Suras ne mažiau kaip n pasikartojančių 
simbolių ar išraiškų 

{n;} 00 
(neras 1000) 
1{2;}00 ⇒  1100, 11100, 111 1

Nuo n iki m pasikartojančių simbolių ar 
išraiškų 

{n;m} 1{2;3}00 ⇒ 11.00, 11100 111100 
(neras 1000) 

Suras vieną ar daugiau pasikartojančių 
simbolių 

@ 1@00 ⇒ 1000, 1100, 11100, 111100 

Suras žodžio pradžią < 
 

<(nu) ⇒  nudažė, nudūrė,  nupiešiau,... 

Suras žodžio pabaigą > 
 

(au)> ⇒  dažau, matau, gliaudau, ... 

' Koks skyrybos simbolis - kabliataškis ar kablelis - bus naudojamas, priklausys nuo „Regionai settings” 
parametrų
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Kaip perkelti lentelę? 
 

 kairįjį pelės klavišą, perkelkite 
elę

 Kaip viename lape išspausdinti kelis 

ygtuką Properties ir perjungikliais „Portrait” bei 
nd n

 

 K

perkeliamą, tinklalapio 
agmentą, pasirinkite meniu punktą Edit ⇒ Copy, 

ki
unktą Edit ⇒ Paste. 

 

Eilutės apačioje kabutes parašysite 

indika ečia, surinkę kodinę 
ką „0132“. 

 

koman
„Parag ine and Page 

reaks ir įjunkite jungiklį „Page break before “. 
 

me pačiame puslapyje, 
ym
m

paspau  Line and Page Breaks ir 
ungiklį „Keep with nesi”. Dabar po 

pažymė

? 
Spragtelėję lentelę pele, ja nurodykite 

žymę, esančią prie viršutinio kairiojo lentelės 
kampo ir, nuspaudę
lent  į kitą vietą.  

?
dokumento puslapius? 

 
Pasirinkite meniu punktą File ⇒ Print, dialogo 
kortelės „Print” laukelyje „Pages per sheet: 
“įrašykite, kelis puslapius talpinti į lapą, laukelyje 
„Scale to paper size:“ -lapo formatą. Paspauskite 
m
„La scape” urodykite, kaip išdėstyti puslapius lape. 

? aip į Word dokumentą perkelti 
intormaciją iš tinklalapio? 

 
Pažymėkite 

fr
grįž te į Word dokumentą ir pasirinkite meniu 
p

? Kaip parašyti kabutes eilutės apačioje? 
 

paspaudą klavišą Alt ir mažojoje klaviatūroje, kai 
torius „Num Lock” švi

se

? Kaip kiekvieną pastraipą pradėti 
naujame puslapyje? 

 
Jeigu norite, kad kiekviena dokumento 

pastraipa prasidėtų naujame puslapyje, sužadinkite 
das Format, Paragraph, dialogo lange 
raph” paspauskite mygtuką L

B

? Kaip padaryti, kad pažymėta pastraipa 
ir po ja esanti pastraipa visada būtų 
tame pačiame puslapyje? 

 
Jeigu norite, kad gretima dokumento 

pastraipa visada būtų ta
paž ėkite pastraipą sužadinkite komandas 
For at, Paragraph, dialogo kortelėje „Paragraph“ 

skite mygtuką
įjunkite j

ta pastraipa esanti pastraipa nebus atskirai 
perkeliama į kitą puslapį.  

 

? Kaip apkarpytiį Word įkeltą 
paveikslėlį? 

 
Jeigu dokumente norite palikti tik dali 

paveikslėlio, jį pažymėkite, paspauskite mygtukų 
rinkinio „Picture“ mygtuką , perkelkite pel
žymekli 

ės 
 ant rėmelio mazgo, nuspauskite

pelės klavišą ir vilkite pelę, kol 
paveikslėlio dalis liks už kontūro stačiakamp
vilkdami galiausiai nukirpsite nereikaling
paveikslėlio dali tada atleiskite klavišą. Jeigu

 kairįjį 
nereikalinga 

io, t.y. 
ą 

 
kirpimo neužteko, kirpkite dar kartą.  

vieno 

Įterptas 
paveikslėlis 

Pelės žymė ją 
velkant 

 

Nurodytas mazgas, 
kuris bus velkamas 

 
 
 

? Kaip padaryti, kad, perkeldama dalį 
pastraipos į kitą puslapį, Word 
programa paliktu arba perkeltu 
daugiau negu vieną pastraipos eilutę? 

Jeigu norite, kad, perkeldama dalį 
astraipos į kitą puslapį, Word programa paliktų 

dialog kite mygtuką 
ine a

 

p
arba perkeltą daugiau negu vieną pastraipos eilutę, 
sužadinkite komandas Format, Paragraph, 

o kortelėje „Paragraph“ paspaus
L nd Page Breaks ir įjunkite jungikli 
,,Widow/Orphan control”. 
 
 
 
 

Apkirptas paveikslėlis 
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raipa? 

ę komandas Insert, 
Break 

a keisti 
okumento paraštes (Margins), rėmelius (Borders), 

puslap  išnašas (Footnotes, 
ndnotes). Įjungę perjungikli „Next page”, skirsnį 

pradėsit

mento formatą? 
 

agmento formatą ir ji suteikti kitam dokumento 
fragmen

n
 klavišą fragmentą, kurio 

rmat
a

!sprag uką 
junkite. 

e hipernuorodą ir kontekstiniame meniu 
mandą 

emove Hyperlink. 
 

klavišą, 
iame meniu 

, paskui komandą 
Language” 

spelling and 

ų? 

andas 
sert ir Text Box. Atsiradus teksto laukeliui su 

ext n“ paspauskite 
ygtukus su 

? Kaip padaryti, kad į kitą puslapį butų 
keliama tik visa past

 
Jeigu norite, kad į kitą puslapį būtų 

perkeliama visa pastraipa, sužadinkite komandas 
Format, Paragraph, dialogo kortelėje „Paragraph 
“paspauskite mygtuką Line and Page Breaks ir 
įjunkite jungikli „Keep lines together”. 

 

? Kaip nepriklausomai keisti dokumento 
pastraipų formatą? 

 
Jeigu norite skirtingai formuoti (Vary the 

Layout) atskiras dokumento pastraipas ar jų grupes, 
suskirstyldte jį skirsniais (Section). Dokumentą 
suskirstysite skirsniais, sužadin

ir dialogo kortelėje „Break” įjungę 
atitinkamą perjungiklį. Skirsniuose galim
d
vertikalų lygiavimą, antraštes, stulpelių skaičių 

ių ir eilučių numeravimą
E

e kitame puslapyje; įjungę „Continuous”, - 
tame pačiame puslapyje; įjungę „Event page”, - 
kitame lyginiame puslapyje, o įjungę „Odd page,” - 
kitame nelyginiame puslapyje. 

Ištrynus skirsnio ženklą už jo buvęs skirsnis 
įgauna aukščiau esančio skirsnio formatą. 
 

? Kaip greitai nukopijuoti dokumento 
frag

Jeigu norite greitai nukopijuoti dokumento 
fr

tui, pažymėkite kopijuojamo formato 
fragmentą (pakanka vieną simbolį), paspauskite 
mygtuką !(Format Pai ter) ir perbraukite pele, 
nuspaudę jos kairįjp
fo ą norite pakeisti. Jeigu norite tokį patį 
form tą suteikti keliems fragmentams, mygtuką 

telėkite dukart. Baigę kopijuoti, mygt
iš

 

? Kaip panaikinti hipernuorodą? 
 

Pele, nuspausdami jos dešinįjį klavišą, 
spragtelėkit
sužadinkite komandą Hyperlink ir ko
R

? Kaip panaikinti klaidų paieškos žymes 
(raudonus ar žalius pabraukimus)? 

 

Pele, nuspausdami jos dešinįjį 
spragtelėkite pabrautą žodį ir kontekstin
sužadinkite komandą Language
Set Language ir dialogo kortelėje „
įjunkite jungiklį „Do not check 
grammar”. 

? Kaip tekstą pasukti 90 laipsni
 

Tekstą pažymėkite, sužadinkite kom
In
pasirinktu tekstu, sužadinkite komandas Format ir 
Text Direction. Dialogo lango „Text Direction - 

Box” laukelyje „OrientatioT
m reikiamos orientacijos tekstu. 

 
 

? 
 

Jeigu rengiamame dokumente norite 

skui paspauskite atsiradusį mygtuką 
en 

norite ymėję reikiamus stilius, 
aspaus

rengiam

i kelis lentelės stulpelius 
an

laukel ažymėję norimas 
ujungti laukelius ir sužadinę komandas Table ir 

Merge 

Kaip rengiamą dokumentų papildyti 
kitų dokumentų stiliais? 

panaudoti kituose dokumentuose naudojamus stilius 
(Style), sužadinkite komandas Tools ir Templates 
and Add-Ins. Dialogo kortelėje „Templates and 
Add-ins “paspauskite mygtuką Organizer. Dialogo 
kortelėje „Organizer“ paspauskite dešinįjį mygtuką 
Close File, pa
Op File. Dialogo kortelėje „Open“ suraskite bei 
iškvieskite šabloną arba dokumentą, kurio stilius 

 naudoti ir, paž
p dami mygtuką Copy, juos perkelkite į 

o dokumento stilių sąrašą „To...“. 
 

? Kaip parengti lentelės antraštes, 
užimančias kelis stulpelius? 

 
Prieš rašydam

užim ą antraštę, pirmiausia antraštės eilutėje šių 
stulpelių laukelius paverskite (Merge) viena 

iuose. Tai padarysite p

či

s
Cells. 

 

? Kaip lentelės laukeliuose vertikaliai 
lygiuoti tekstą? 
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andas Table, Table 
Properties... ir dialogo kortelės „Table 

e 
ragtelėkite paveikslėlį, kuriane pavaizduotas 

reikiam

ičius, pažymėkite stulpelį su 
ičiais. pragtel
uo

dešim buliavimo ženklą ir 
orizontaliojoje liniuotėje spragtelėkite pele toje 

vietoje,

s paraščių pločius? 

nuo 
ukelių rėmelių (paraščiųplotį), pažymėkite lentelę, 

sužad
o

t
„Table Options“ laukeliu

? Kaip į lentelės laukelius įrašyti 
vertikalų tekstą? 

 
rba pa

ių juostos kairiajame 

pele 
ragtel

skirkite (Split) langą į dvi 
avarankiškai valdomas dalis. Langą galėsite 

r pele 
uvilkę skiriamąją liniją į vietą. Iš vienos lango 

ustatyti jo 
formatą? 

Jeigu Word programos nustatytas 
dokumento formatas netinka, sužadinkite 

Parašt
etup. go kortelėje „Page Setup\Margins “ 
ęjų pločius į tam skirtus laukelius (Top, Bottom, 

Norėdami vertikaliai lyguoti tekstą lentelės 
laukeliuose, pažymėkite laukelius su lygiuojamu 
tekstu, sužadinkite kom

Properties\Cell” laukelyje „Vertical alignment” pel
sp

as lygiavimas. 
 

? Kaip lentelės stulpeliuose lygiuoti 
dešimtainius skaičius? 

 
Norėdami lentelės stulpeliuose lygiuoti 

dešimtainius ska
ska  S ėdami pele horizontaliosios 
lini tės kairėje esantį mygtuką, pasirinkite 

tainių skaičių ta
h

 kur turi būti sveikųjų ir dešimtainių 
skaičiaus dalių skirtukas. Visi stulpelio skaičiai bus 
sulygiuoti pagal skirtukus. 

 

? Kaip keisti lentelė
 

Norėdami pakeisti tekstų atstumą 
la

inkite komandas Table, Table Properties..., 
go kortelėje „Table Properties\Table“ 

ions..., dialogo kortelės 
ose „Top:”, Bottom:

dial
paspauskite mygtuką Op

”, 
„Left:”, „Right:” įrašykite reikiamus atstumus ir 
paspauskite OK. 
 

 
Norėdami į laukelį įrašyti vertikalų tekstą

a keisti jo orientaciją, pažymėkite laukelius, 
kuriose keisite teksto orientaciją, sužadinkite 
komandas View, Toolbars ir Tables and Borders. 
Mygtukų juostoje spauskite mygtuką tol, kol tekstas 
bus reikiamai orientuotas. 

 

? Kaip įjungti lietuvišką klaviatūrą? 
 

Lietuvišką klaviatūrą įjungsite, 
paspausdami užduoč

kampe esantį mygtuką ir 
atsiradusiame meniu  

sp ėdami „Lithuanian”. Klaviatūrą perjungsite 
taip pat paspausdami klavišus Left Alt+Shift arba 
Ctrl+Shift. 

 
 

 

? Kaip perskirti dokumentą į dvi dalis? 
 

Jeigu, rengdami dokumentą, norite matyti 
nutolusias jo dalis, per
s
perskirti sužadinę komandas Window, Split i
n
dalies į kitą žymeklį perkelsite spragtelėdami pele 
arba paspaudę klavišą F6. 

Perskyrimą panaikinsite, perskyrimo liniją 
dukart spragtelėję pele arba sužadinę komandas 
Window ir Remove Split. 
 

? Kaip orientuoti puslapį ir n

 

komandas File, Page Setup... Dialogo kortelėje 
„Page Setup\Paper Size” išskleiskite dokumento 
matmenų sąrašą ,,Paper size:” ir nurodykite 
standartinį popieriaus formatą (pvz., A5) arba 
popieriaus plotį įrašykite į laukelį „Width:”, o 
aukštį į laukelį „Height:”. Jeigu norite popieriaus 
lapą, orientuoti horizontaliai, pele arba paspausdami 
klavišus Alt+C laukelyje „Orientation” įjunkite 
jungiklį „Landscape “. 
 

? Kaip nustatyti puslapio paraštes? 
 

es nustatysite sužadinę komandas Eile, Page 
.. ir dialoS

įraš
Left, Right). Įjungę jungiklį „Mirror margins”, taip 
suderinsite dokumento paraštes, kad galėsite 
spausdinti abiejose lapo pusėse, Įjungę jungiklį „2 
pages per sheet”, viename lape galėsite išspausdinti 
du į jį telpančius dokumento puslapius. 
 

? Kaip rengti išnašas (Footnotes)? 
 

Išnašomis dokumente žymimos citatos, 
parafrazės, santraukos ir komentarai. Norėdami 
įvesti išnašą į tekstą, žymekliu nurodykite, kurioje 
teksto vietoje jąžymėsite (pvz., čia1), sužadinkite 
Insert, meniu komandą Footnote... Atsiradusiame 
lange nurodykite, ar išnašas numeruoti automatiškai 
(AutoNumber), ar žymėti specialiu simboliu 
(Custom mark:); kur jos turėtų būti -puslapio 
(Footnote) ar dokumento (Endnote) pabaigoje, 
paspauskite mygtuką OK ir parašykite išnašą. 
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t 
Eguation sud

 

je „ Scale:” 
si

ėsi lius išretinti, o pažymėję 
Conden

sužadinkite programa 
dd/ ord 

tup 
rogram

o kompaktinį diską, 
ialogo kortelės „Add/Remove Programs 

pažym  ir paspauskite 
ygtuką „Add/Remove “. 

Norėdami išsaugoti dokumento versiją, 
užadinkite komandas File, Versions... ir 

gtu
Save s on version:” ir 
aspaus

 

? Kaip iškviesti programą Microsof
ėtingoms formulėms 

rašyti? 
 

Sudėtingoms formulėms rašyti yra skirta  
programa Microsoft Eguation. Norėdami rašyti 
formulę, pirmiausia dokumente pele nurodykite 
vietą, kur rašysite formulę, paskui sužadinkite 
komandas Insert, Objects..., dialogo kortelės 
„Object\Create New” sąraše „Create New:” pele 
dukart spragtelėkite „Microsoft Eguation”. 

? Kaip įterpti į tekstą specifinį simbolį? 
 

Jeigu norite įterpti į tekstą specifinį simbolį 
(pvz.: μ), žymekliu nurodykite vietą, kur jį įterpti, 
sužadinkite komandas Insert, Symbol…dialogo 
kortelės ,,Symbol” išskleidžiamajame šriftų sąraše 
,Font:” bei ,,Subset:” suraskite ir pažymėkite šriftą 
(pvz., Symbol); simbolių lentelėje pele dukart 
spragtelėkite reikiamą simbolį. 
 

? Kaip keisti tarpus tarp simbolių ir jų 
padėtį eilutėje? 

 
Komandomis Farmat bei Font... iškvietę 

dialogo kortelę „Font” ir paspaudę mygtuką 
Chafacter Spacing, dialogo kortelės 
„Font\Character Spacing” laukely
galė te susiaurinti arba praplėsti teksto fragmentą. 
Laukelyje „Spacing:” pažymėję „Expanded”, 

te simbogal
„ sed” , sutankinti nurodytų taškų skaičiumi. 

Laukelyje „Eosition” galite nurodyti, per 
kiek taškų pakelti (Raised) arba nuleisti (Lowered) 
pažymėtą teksto fragmentą. Tiksliai atstumus tarp 
simbolių ir simbolio padėtį eilutėje nustatysite įrašę 
atstumą į laukelius „By:”. 

Jeigu sąraše tokio pavadinimo nėra, 
programą Microsoft Eguation reikia įdiegti. 

Tam išjunkite Word, atidarykite langą „ 
Control Panel”, 
„A Remove Programs “. Jeigu W
programa buvo įdiegta naudojant Office Se
p ą, dialogo kortelės „Add/Remove 
Programs Properties Mnstall, Uninstall” sąraše 
pažymėkite „Microsoft Office” ir paspauskite 
mygtuką „Add/Remove”. Įdėkite „Microsoft 
Office” įdiegimo kompaktinį diską ir vykdykite 
ekrane pasirodančius nurodymus. Jeigu Word 
programa buvo įdiegta atskirai, įdėkite 
„Microsoft Word” įdiegim
d
PropertiesMnstall, Uninstall” sąraše 

ėkite „Microsoft Word”
m

 

? Kaip išsaugoti „Word”dokumento 
versiją? 

 

s
paspauskite dialogo kortelės „Versions in...” 
my ką Save Now... Užpildykite dialogo kortelės 

 Version “ laukelį „Comment„ 
p kite mygtuką OK. 

Paspaudę dialogo kortelės „Versions in...” 
mygtuką Open, iškviesite sąraše „Existing Versions 
“ pažymėtą dokumento versiją, o paspaudę mygtuką 
Delete, ją ištrinsite.  
 

? Kaip pakeisti dokumento šabloną? 
 

Jeigu norite pakeisti dokumento šabloną, 
sužadinkite komandas Tools ir Templates 
andAdd-Ins, dialogo lango „Templates and Add-
ins” laukelyje „Document tempiate” įrašykite 
norimo šablono adresą. Jeigu šablono adreso 
neatsimenate, paspauskite mygtuką Attach..., 
raskite šabloną ir, įkėlę jį į laukelį „Document 
template “, paspauskite OK. 
 

? Kaip parengtus šablonus įkelti į 
dialogo kortelę „New”? 

 
Dialogo langą „New” papildysite naujais 

šablonais, įjkeldami juos į katalogą Templates. 
Kataloge Templates sukūrę naują katalogą, „New” 
sukursite to paties pavadinimo naujos kortelės 
mygtuką. 
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 Kaip automatizuoti vieno tipo objektų 
lietuvišką numeravimą? 

 
Vieno tipo objektams (pvz., paveikslėliams, 

lentelėms) numeruoti skirta komanda Caption..., 
esanti Insert meniu. Jeigu norite automatizuoti, 
pavyzdžiui, paveikslėlių numeravimą, žymekliu 
nurodykite numerio įterpimo vietą ir sužadinkite 
komandą Caption... Dialogo lange „Caption” 
nurodykite arba sukurkite reikiamą pavadinimą 
(Label) ir paspauskite OK. 

Automatinį objektų numeravimą 
lietuviškame tekste apsunkina tai, kad Word 
programa numerį rašo po pavadinimo (pvz., pav. 1), 
o reikia, kad jis būtų prieš pavadinimą. Kai 
numeriuose yra ir skyriaus numeris, šio trūkumo 
galima išvengti, vietoj objekto pavadinimo rašant 

skyriaus numerį, pavyzdžiui, „2.”, ir po numerio, 
pavyzdžiui, „2.17”, prirašant „pav.”  
 

? Kaip sudaryti dokumento turinį? 
 
Jeigu dokumento skyriai yra parašyti nurodant jų 
stilių ir prioritetus (pvz., Heading 1, Heading 2), 
norėdami sudaryti turini žymekliu nurodykite tą 
dokumento vietą (pradžią ar pabaigą), kur norite 
matyti turini sužadinkite komandas Insert, Index 
and Tables... Dialogo kortelėje „Index and 
Tables\Table of Contents” parinkite turinio stilių ir 
paspauskite OK. Paspaudę mygtuką Options..., 
dialogo lange „ Table of Contents Options “ 
galėsite nurodyti turinio teksto stilių.

 

?


